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1 Introduction

1.1 Software purpose

MXChange is designed to integrate MITSUBISHI ELECTRIC automation development
tools into a single environment which harmonises programming, supervision, network
configuration, and simulation components.

Examples:

! MELSEC MEDOC plus
IEC 1131-3 programming and documentation system providing the user with
facilities for structured programming for MELSEC PLC including function blocks

! ProfiMap
Visual configuration software package for open networks such as PROFIBUS DP,
PROFIBUS FMS, and MAP 3.0

! MX32 SCADA
Process visualisation and supervisory system

! MAC Programmer+
Visual programming tool for operator terminals

1.2 General features

MXChange provides the following features:

! Simultaneous definition of I/O references in multiple packages and projects

! Automatic transfer of changes of I/O references to other parts of the automation
project

! Automatic transfer of ProfiMap POU blocks to the corresponding MELSEC MEDOC
plus projects

! Import and export of parts of the MXChange configuration for use with other
MXChange servers

! Import and export in Microsoft Excel compatible format (CSV)

! Simultaneous generation of multiple tags for all projects based on a supplied
pattern

! Synchronisation mechanism

! Security mechanism with log in and password
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1.3 This manual is a compact guide...

... to use MXChange suitable for experienced users and factory automation
programmers. The manual explains the terms and structural concepts of the software
and describes how to use MXChange including sample projects.

1.4 If you are not yet familiar with MS Windows ...

... please read the Windows Fundamentals section in the Windows User's Guide or
work through the Windows Tutorial accessible via the Help function in the Windows
Start menu.

1.5 If you encounter any problems...

... or if you have questions concerning MXChange or the automation development
tools to be integrated, please first refer to the manuals. Many answers and solutions
can also be found directly in the MXChange context-sensitive online help system,
which can always be accessed by pressing �. Make use of the Index command in
the Help menu as well, as this will often locate the information you need. If you do
not find any answers, contact your local MITSUBISHI ELECTRIC representative or call
our European headquarters in Ratingen directly.
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1.6 Typographic conventions and other hints

Menu names, menu commands, submenu commands, and dialog box options are
printed in boldface type.

Buttons are generally presented in the same way as they appear in the window
(e.g. ).

These two symbols are used to identify the separate instructions for mouse and
keyboard users.

Examples: This symbol identifies examples.

Note: This symbol draws your attention to notes, hints and valuable or useful
information.

WARNING: Always pay particular attention to the warnings marked by this symbol.
If you do not follow these instructions, data loss, hardware damages, or other
serious problems may be caused.

This symbol draws your attention to additional information.
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2 Installation

2.1 System requirements

To install the MXChange software package, your computer has to meet the following
requirements.

2.1.1 Minimum hardware configuration

! Pentium class PC

! 64 MB RAM

! Hard disk with at least 40 MB free space

! CD-ROM drive

! SVGA compatible graphics adapter

! Mouse

2.1.2 Software requirements

The software runs on the following graphical operating systems:

! MS Windows 95 or 98

! MS Windows NT v4.0 with Service Pack 4 or higher

! MS Windows 3.11 - for the stand-alone 16-bit Tag Editor only

! Installed TCP/IP network protocol (included in MS Windows)
Refer to the MS Windows manuals or online help for the installation of the TCP/IP
network protocol.

2.2 Copyright

IMPORTANT NOTICE: MXChange is protected by copyright. By operating the
distribution disks package you automatically accept terms and conditions of the
Licence Agreement. You are permitted to make only one single copy of the original
distribution disks for your own backup and archiving purposes.
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2.3 Software installation

2.3.1 MXChange software setup

The MXChange software package contains the following programs:

! 32-bit MXChange server for MS Windows 95/98 and NT

! 32-bit MXChange tools including the Super Project Manager with integrated
Tag Editor for MS Windows 95/98 and NT

! 32-bit MX Interface for MS Windows 95/98 and NT

! 16-bit MXChange Tag Editor - stand-alone version for MS Windows 3.11

To install the MXChange software from CD-ROM under MS Windows 95/98, you
need to have MS Windows installed properly. For an installation under Windows NT
you need to be logged in with administrator privileges.

Please close all other running software and installation programs before installing
MXChange.

2.3.2 Button functions

You will leave the current menu and enter the next menu.

You will go to the previous menu.

You will abort the installation procedure.
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2.3.3 Installing MXChange on your hard disk

The MXChange server, the MXChange tools, and the MX Interface are delivered
on one CD-ROM and are installed by one combined installer. You can select three
different setup types: Typical, compact, and custom.

To start the installation, proceed as follows:

a Start Windows.

b Insert the CD-ROM into your CD-ROM drive.

c Execute the Setup.exe file from the CD-ROM. The Setup.exe file is located in:

MyCDROM:\MXChange\Disk1\Setup.exe

n Double-click on the setup.exe file within the Explorer

or

n select the Run command from the Windows Start menu and enter the
desired path where "MyCDROM" is the drive letter:
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d Follow the instructions guiding you through the installation:

e Read carefully through the license agreement and follow the instructions given:
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f Select the desired installation type. The default setting is Typical. If you choose
Typical or Compact, you will proceed with step h. The Custom setup lets you
choose the components to be installed individually.

g Click on the checkboxes to deselect or select individual items:
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A. Install the MXChange server only

At least one MXChange server installation is compulsory across your TCP/IP network
or on your local computer. The MXChange server provides the connectivity between
your automation development tools.

B. Install the MXChange tools only

The MXChange tools include the Super Project Manager with which you can maintain
your common databases.
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C. Install the MX Interface only

The MX Interface is only needed for a connection to MX SCADA.
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h The default destination folder is shown below:

i You can change the destination folder by clicking on the Browse button:
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j The default program folder is shown below. You can select another program
folder from the listbox or enter a new one in the entry field:

k The MXChange installation is complete:
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2.3.4 Dongle protection

The software is copy protected via a hardware dongle included in the software
package. Plug the hardware dongle on the parallel port of your personal computer.
The signals of the port are connected through, so you can connect parallel
peripherals (e.g. printers) to the dongle.

Without the dongle connected, MXChange will only run in evaluation mode with
the following restrictions:

n Maximum of 20 tags
n No network capabilities (stand alone system only)
n Only one server instance per computer

For the installation you do not need the dongle.

MXChange Software Manual

2 – 10 Installation

In
st

al
la

ti
on



2.3.5 Installing the external Tag Editor (16-bit) on your hard disk

The external Tag Editor (16-bit) is intended for personal computers running MS
Windows 3.11.

To start the installation, proceed as follows:

a Start Windows.

b Insert the CD-ROM into your CD-ROM drive.

c Execute the Setup.exe file from the CD-ROM. The Setup.exe file is located in:

MyCDROM:\mxchange\disk1\setup.exe
"MyCDROM" is the drive letter of your CD-ROM drive.

Double-click on the setup.exe file within the File Manager.

d Follow the instructions of the InstallShield Wizard guiding you through the
installation.

e Specify the destination directory.
The default path is:

C:\programf\melsoft\mxchange

f Specify the program folder the MXChange icons are added to.
The default program folder is MXChange
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3 System Description

3.1 System concept

MXChange provides an integrated development environment which integrates the
programming and configuration tools.

MXChange:

n reduces the development time of an application consisting of several automation
components (i.e. PLCs, HMIs, SCADAs, and networks).

n removes the need to configure the same data in more than one package.
n reduces the number of operator input errors.

A typical distributed control system is shown in the diagram below:

In this diagram a networked PLC system controls many devices on a PROFIBUS
network configured with ProfiMap. Several MX SCADA PCs and operator terminals
are provided for operator display and control. The configuration programs for each
part of the system are on different PCs.
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Although all these PLC systems share the same I/O and network, each configuration
program operates independently, i.e. that every I/O reference must be defined
separately in each package. This is time-consuming and there is the potential for
typing errors and configuration mismatches which can be costly to track down and
repair.

MXChange provides a way for the configuration packages to co-operate, allowing the
definition of I/O references in several programs at the same time. If an I/O address is
changed in one package, the change is propagated automatically to the other
packages.

3.2 Architecture

The overall architecture of MXChange is shown in the diagram below:

The system has a client/server architecture. Each of the configuration programs is
modified to communicate with a common database server. All communications are
performed via the server. The Super Project Manager it able to export data to
programs like Excel.
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3.3 Use

An automation project is setup by adding all individual projects and programs to it
(e.g. PLC programs and HMI projects). The entire automation project is a hierarchical
tree where the individual projects and programs are the nodes. Each individual node
may further branch off containing for example local I/Os, communications cards, or
device drivers.

Note: The term node in general refers to the connecting points that form a tree
structure. MXChange represents an entire automation project as a hierarchical tree
consisting of nodes. Any item displayed in the project tree is a node. Each single
node represents an individual PLC program, HMI project, I/O communications point,
device driver, etc.

When variable names or I/O points are added to the system in any configuration
package, the user can declare them as MXChange tags. Limited information about
MXChange tags (e.g. name, description, address) is stored in the MXChange
common database, as well as in the project or program where it was defined. The
user is automatically asked whether the tag should be created in the other
automation projects connected as well. When the MXChange tag is created, the user
is prompted for any details which are needed by the other target projects, but which
are not available in the configuration package where the tag was defined. If any
detail can be calculated automatically, the user is not prompted for it. There are also
reasonable default values for all fields.

Changes may be for the addition or modification not only of MXChange tags but also
for more specific changes such as the export of a new POU block from ProfiMap to
MELSEC MEDOC plus.

When an MXChange tag is deleted, the system prompts to see whether the tag
should also be deleted in other applications. The tag will be removed from
MXChange only when it no longer appears in any other configuration program.
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Whenever possible, changes to one application are passed on to all other running
applications. However, if the user has disabled this option, changes will be dealt with
only on start-up and save. Communication always occurs via the MXChange server.

Note: If the MXChange server is not available, applications will back up any changes
locally to retransmit to the server when it is online again.
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4 Getting started

The following example shows the principles of how you can easily establish an
automation project by adding your projects to the Super Project Manager.

4.1 Integrating a MELSEC MEDOC plus project in MXChange

This chapter describes how to link an existing MELSEC MEDOC plus project into the
common database of MXChange.

1. Start the MXChange server

Click on to open the Windows Start menu and select the menu item
Programs/MXChange/MXChange Server.

Start the MXChange server either on your local personal computer or on a different
one you are connected to via the TCP/IP protocol.
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Once the MXChange server is running, it does not need any further setup or
maintenance. Therefore, you can minimise it but let it run in the background.

2. Start the Super Project Manager and login

Click on to open the Windows Start menu and select the menu item
Programs/MXChange/Super Project Manager.
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The Login to MXChange server dialog appears automatically:

The User Name cannot be changed and is fixed to Admin.

The default Password is "" (leave it blank).

n Confirm by clicking .

Note: Upper-case and lower-case characters are distinguished by the MXChange
server.

The Super Project Manager tries to establish the connection to the server.

If there is no MXChange server started on the selected personal computer, an error
message is returned:
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If the connection is established, the Super Project Manager appears:

The Project Navigator window on the left shows all projects connected to
MXChange as a tree of hierarchical nodes.

The Tag Editor window on the right (here still blank) lists all tags of different projects
to be used with MXChange.

3. Open MELSEC MEDOC plus project and log on

To connect a MELSEC MEDOC plus project to MXChange for the first time, create a
MELSEC MEDOC plus project called GETSTART. Refer to the MELSEC MEDOC plus
manual for details. Open this project and enable the MXChange support:

For activating the MXChange feature, refer to the manual of your automation
software.
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The MXChange server - Log On dialog appears automatically:

Enter MXChange Server, User Name, and Password:

MXChange Server: The TCP/IP address of the personal computer where the
MXChange server is running.
If the server is running locally, click on Use Local Address
for the TCP/IP address of your local personal computer.

The defaults for the user name and password are:

User Name: Admin
Password: "" (leave it blank).

Note: Upper-case and lower-case characters are distinguished by the MXChange
server.
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4. Add the MELSEC MEDOC plus project to MXChange

As your MELSEC MEDOC plus project is connected to the server, MXChange notes
that this project does not exist in the common database and asks whether you want
to add it:

confirm by clicking and the MELSEC MEDOC plus project will be added to
the Project Navigator of the Super Project Manager:

As you have made some changes in the common database, MXChange will inform
the MELSEC MEDOC plus project about these changes. Any changes made in a
project will be synchronised with MXChange when you save your project:
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5. Tag MELSEC MEDOC plus variables for MXChange

Now specify the variable Hello to be included in the common database of
MXChange. Open the MELSEC MEDOC plus Global Variable List and click on the
MXChange checkbox of the variable Hello:

6. Tags are added to MXChange

After the MELSEC MEDOC plus variable HELLO has been tagged, save your MELSEC
MEDOC plus project to transfer the changes to MXChange. The MELSEC MEDOC plus
project automatically inserts an MXChange tag and a MELSEC MEDOC plus tag.
The view is refreshed by clicking on in the Super Project Manager.

The first variable name HELLO is included in both, the MELSEC MEDOC plus project
and the MXChange tags in the Super Project Manager.

Note: Any changes you have made in the PLC project within MELSEC MEDOC plus
are transferred to MXChange only if you save the PLC project.
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5 Super Project Manager

The Super Project Manager is the main interface between the user and the
MXChange server. The Super Project Manager is the central tool that lets you
manage different automation projects from just one single common interface.

5.1 Hierarchical structure

The Super Project Manager provides an overview of the complete automation project.
The Super Project Manager provides a hierarchical structure consisting of nodes:

By means of the hierarchical structure you can copy and paste parts of the
configuration to easily generate new MXChange tags from existing tags.
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5.1.1 MELSEC MEDOC plus PLC project structure

Each MELSEC MEDOC plus project describes the configuration of a single PLC. To
connect another package to the PLC, the package must know which CPU is used and
which communications cards are attached. The hierarchichal structure stores this
information.

DP configuration structure

A single DP master (I/O card) is a ProfiMap project. This describes a number of DP
slaves and any I/O attached to them. At the simplest level, a DP slave can be seen as
two ranges of memory mapped into the PLC, containing raw input and output data.
I/O points may be defined within this data, in a similar way to the tags on other
systems - they are not read individually, but are used as markers into the structure
when creating the corresponding MELSEC MEDOC plus tags.

A list of known DP slaves is maintained in the MXChange database. New devices can
be added by providing a GSD file, to determine the slave details and any modules
which may be added to the device.
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5.1.2 MP+ project structure

MP+ projects are structured as shown below:

Each device is subordered to the PLC connection to determine the communication
with PLCs in a similar way to MX SCADA projects.

5.1.3 MX SCADA structure

To define an I/O point, MX SCADA needs to know which driver fetches the
information and which channel and device are used.

Although the channels and devices appear identically, there are different classes
depending on whether Ethernet or serial communication is used. Ethernet drivers
connect to a TCP/IP card in the PLC, whereas serial drivers connect to a CPU or serial
communications card.
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Note: If you intend to connect a MELSEC MEDOC plus project and an MX SCADA
project, ensure that the I/O card of the MELSEC MEDOC plus project corresponds to
the MX driver and the respective channel and device of the MX SCADA project.
The driver, channel, and device of the MX SCADA project must be added manually to
MXChange.
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5.2 Starting the MXChange server

The MXChange server is the central interface between the software tools and the
common database. When the MXChange server is started, it does not require any
further setup or maintenance. The MXChange server must run either on the local
personal computer or on a remote computer accessible via TCP/IP network.

Start the MXChange server from the MS Windows Start/Programs menu (or from
where you installed it):

SP
M

Super Project Manager 5 – 5

Software Manual MXChange



You can start more than one MXChange server on one single personal computer.
Each MXChange server handles an individual database. The additional MXChange
servers are numbered successively (Server:1, Server:2, ...).

Three MXChange servers running on one single computer:

Click on Stop to suspend the service temporarily and restart it with Start.
Click on Stop & Close to exit the server.SP

M

5 – 6 Super Project Manager

MXChange Software Manual



5.3 Multiple automation projects handling

In order to handle more than one automation project within the Super Project
Manager you have to start another MXChange server on the same personal
computer. Each server handles its individual database. The additional server instances
retain their name with an appended ":n" (where n is a successive number beginning
with 1):

Within the Super Project Manager you can log in to more than one server instance
and handle the corresponding projects in individual windows. For each activated
server window you can create, open, close, and delete an individual project database:
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5.4 Starting the Super Project Manager

Start the Super Project Manager from the MS Windows Start/Programs menu (or
from where you installed it):

5.4.1 Logging in

When starting up or on selecting Log in from the File menu, a dialog box appears
requesting the server name with which to connect, a user name, and password.

The User Name currently cannot be changed and is fixed to Admin.
The default Password is "" (leave it blank).

Note: The server distinguishes upper-case and lower-case characters within the user
name and password.

launches the server browser window. After is selected, the main
project window will be opened with a connection to the given server.
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5.4.2 Server browser

The server browser lists all MXChange servers selectable across the current TCP/IP
network or environment. Select one of these and click .

If there is more than one MXChange server running on one single personal computer,
the additional MXChange servers are numbered successively (Server:1, Server:2, ...).

If there is no MXChange server available, the browser window remains blank. If you
have already entered a server name, user name, and password in the login window,
an error message appears:

In this case start the MXChange server with the required database on your local
personal computer or on a remote one accessible across the TCP/IP network.
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5.5 Using the Super Project Manager

5.5.1 Main project window

When a connection to the server has been established, the main project window is
displayed.

The title bar of the window displays "SERVER NAME / COMMON DATABASE NAME".

Click on to expand and on to collapse nodes in the Project Navigator window.

The Tag Editor window is part of the MXChange Tag Editor, which is integrated into
the Super Project Manager. The Tag Editor window displays the MXChange tags and
data.
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5.5.2 Refreshing the project window

To update the tree in the main project window, select Refresh from the View menu
or from the toolbar. The tree will also be updated if it is changed by Add node,
Delete node, Modify node, Cut, or Paste.

5.5.3 The Project Navigator context menu

Right-click on any node in the Project Navigator window to open the context menu:

All menu functions apply to the currently selected node.

5.5.4 Searching the database

To search the database the following context menu functions are avaliable:

n Find MXC reference
n Find MM+ reference
n Find MP+ reference
n Find MX reference
n Find Profimap reference

The context menu functions allow you to search the database for an MXChange tag
in the different projects and vice versa. The tag to find is the currently selected node.
If it has been found, the reference will be highlighted in the Project Navigator. If
more than one reference was found, the next reference can be highlighted by
selecting Find next. When no more references exist, the Find next option will be
disabled.
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Example

You want to find out to which project(s) an MXChange tag belongs.

Right-click on the desired MXChange tag to open the context menu and select
Find ... reference:

If the tag occurs in the selected project type, it will be highlighted:

If the tag does not occur in any project of the selected type, the following message
appears:
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5.5.5 Run application

Each project in the Super Project Manager should have an associated configuration
program. These may include MX SCADA, MELSEC MEDOC plus and ProfiMap. If you
select this option, the correct configuration program will be launched. Initially, the
path of the configuration program may be missing; if so, the following dialog box will
appear in which you can select the correct program.

The file path and file name of the project and the name of the computer where the
project is stored can be edited in the Edit Node dialog. Right-click on the project
node you want to edit in the Project Navigator window and select Edit Node:
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5.5.6 Export

Selecting Export to file provides two formatting options:

n Comma Separated (report) exports the entire project in a viewable format.
n Comma Separated (for import) exports only the tags for the PLC currently

highlighted and their corresponding MXChange tags in a format allowing the tags
to be imported into another project.
Only Melsec Medoc plus projects can be exported in the importable format.

The file format is Comma Separated Value (*.csv). Therefore, it can be read by
various application programs, for example by MS Excel.

You can specify the path and file name in a common Windows dialog.
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Sample file: Export comma separated for import
MXC_EXP_1.1
HMI3,MM+ Project (A)
SET_POINT,D2,INT,,0,2,1,SET_POINT,VAR_GLOBAL,0
TRUCK_POSITION1,M1,BOOL,,0,0,1,TRUCK_POSITION1,VAR_GLOBAL,0
TRUCK_POSITION2,M2,BOOL,,0,0,1,TRUCK_POSITION2,VAR_GLOBAL,0

Sample file: Export comma separated for report
MXChange Configuration

Server Name:,PDP-NT-SERVER02
Database name,BLANKBASE
Exported on,11/05/99 10:58:09,

MXChange Tags

Name,PLC,Type,Address (Mitsubishi),Address (IEC),IO
Bit,Size,Elements,Description

SET_POINT,HMI3,INT,D2,%MW0.2,,2,1,
TRUCK_POSITION1,HMI3,BOOL,M1,%MX0.1,,0,1,
TRUCK_POSITION2,HMI3,BOOL,M2,%MX0.2,,0,1,

MM+ Project,HMI3

Cards,
TCP/IP Card,TCP/IP10,Slot,1,IP Address,10.200.22.10,Port,1280,

Name,Address (Mitsubishi),Address (IEC),Function
Block,Instance,Class,Remark

SET_POINT,D2,%MW0.2,None,None,VAR_GLOBAL,Remark,
TRUCK_POSITION1,M1,%MX0.1,None,None,VAR_GLOBAL,Remark,
TRUCK_POSITION2,M2,%MX0.2,None,None,VAR_GLOBAL,Remark,

MAC Project,Station1

Connection "MAC PLC connection" to PLC "HMI3"
Name,Address (Mitsubishi),Address (IEC)
SET_POINT,D2,%MW0.2
TRUCK_POSITION1,M1,%MX0.1

MX32 Project,Cell A1

Driver,MQE driver,
Channel,Channel1,

Device,M11,
Name,Address (Mitsubishi),Address (IEC),Scan Time,Low EGU,High

EGU,Units,Open Label,Close Label
SET_POINT,D2,%MW0.2,1,-32768.00,32767.00,,Open,Closed,
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5.5.7 Import

Selecting Import from file from the File or context menu brings up a file/open
dialog box to select an appropriately formatted comma separated file (*.csv). This file
when selected will import the MXChange tags into the according Melsec Medoc plus
project:

Only MXChange tags can be imported. A new Melsec Medoc plus project node can
not be added via the import function. Therefore, a Melsec Medoc plus project node
with an I/O connection (e.g. PLC local I/O) must already exist.

Import into selected automation project

If you select the top node automation project navigator and then execute the
import function, the included Melsec Medoc plus projects will be checked for their
name and their CPU type. Only if name and CPU type match, the MXChange tags will
be imported into the corresponding Melsec Medoc plus project.

Import into selected Melsec Medoc plus project

If you select any Melsec Medoc plus project and then execute the import function,
the MXChange tags will be imported into the selected project, regardless of its name
or CPU type.
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Resolve import data conflicts

Conflicts occurring between the import file data and the server database will be
displayed in a dialog box. To resolve these conflicts you have to specify the master
data source for each tag.

The default master source is the server database. Activate the File version checkbox
to select the import file as source for the respective tag:

Note: All data fields of the import data are checked, not only those displayed in the
Resolve Conflicts dialog. Therefore the Resolve Conflicts dialog might come up
although not displaying the explicit conflict. In this case check the import file for
differences.
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Importable data format

The data format is *.csv (comma separated value) and can be imported and exported
by most spreadsheet programs. The layout is very simple and starts with a short
header, followed by a list of tags.

Header:

The first line indicates the export file version:

MXC_EXP_1.1

The second line indicates the project name and project type:

Project name,Class type

List of tags:

<tag>,<address>,<type>,<description>,<level>,<elemsize>,<elems>,[...]

The I/O bit column in the tag editor is not directly exported but included in the
address in dot notation (e.g. D2.1).

[...] is the MM+ specific data as follows:

<name>,<class (default = VAR_GLOBAL)>,<level>

Only the following fields have to be specified:

<tag>,<address>,<type>,<description>

In this case for the remaining fields default values are used:

level = 0
elemsize = 0
elems = 1
name = tag name
class = VAR_GLOBAL
level = 0

Sample file: Importable data format
MXC_EXP_1.1
HMI3,MM+ Project (A)
SET_POINT,D2,INT,,0,2,1,SET_POINT,VAR_GLOBAL,0
TRUCK_POSITION1,D0.1,BOOL,,0,0,1,TRUCK_POSITION1,VAR_GLOBAL,0
TRUCK_POSITION2,M2,BOOL,,0,0,1,TRUCK_POSITION2,VAR_GLOBAL,0

Note: MS Excel uses different separator characters for the CSV export depending on
the installed language version. The English language version uses the "," character as
separator. The German version for example uses the ";" character as separator.
MXChange checks the separator character and accepts both.
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5.5.8 Logging out

To shut down the connection to the server and to close the main project window for
the connection, select Log out from the File menu.

5.5.9 Closing the application

To close all windows and to shut down the application, select Exit from the File
menu.
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5.6 Nodes

The complete Super Project is represented as hierarchical nodes. Within this hierarchy
each node itself can have a parent node above and a child node below. By this the
relationship between the items within projects is clearly indicated. The top level node
is the automation project manager covering all individual projects.

Note: The term node in general refers to the connecting points that form a tree
structure. MXChange represents an entire automation project as a hierarchical tree
consisting of nodes. Any item displayed in the project tree is a node. Each single
node represents an individual PLC program, HMI project, I/O communications point,
device driver, etc.

5.6.1 Adding a node

To add a node, select Add node from the Edit menu or from the Project Navigator
context menu. A dialog box appears in which the node type can be selected. The
node types which can be selected depend on the project type they are added to.
Below the node types for a MELSEC MEDOC plus project are shown:

The new node will be added below the currently selected node. Only nodes of an
appropriate type can be added. After the node type has been selected, an edit
window will be opened in which the appropriate data can be entered.
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Add Node dialog. The entries depend on the selected parent node. The example
below shows how to add an MX project to the automation project navigator:

Note: Each automation development tool is capable of inserting a project node so
that all this information will be generated automatically.

5.6.2 Node dialog browsers

There are browse buttons available for some types of entry fields in the node dialogs.
If the field requires a computer name, directory folder or file name, then a browse
buttons are available. The following dialogs appear accordingly.

Example Add node dialog:
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Browse for computer

Browse for folderSP
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Browse for file

Select the relevant item, and click OK, and the selection will be inserted into the field.

5.6.3 Editing a node

To modify the currently selected node, select Edit Node from the Edit menu or from
the Project Navigator context menu. Then an appropriate dialog box appears which is
identical to that for adding a node.

Edit Node dialog. The entries depend on the selected node. The example below
shows how to edit a TCP/IP card of a MELSEC MEDOC plus project:
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5.6.4 Deleting a node

To delete the currently selected node, select Delete Node from the Edit menu or
from the Project Navigator context menu.

WARNING: Deleting a node cannot be undone.

5.6.5 Cut, copy, and paste

When Cut or Copy is selected, the currently selected node including all child nodes is
copied. In case of Cut, the node is then deleted. Selecting Paste will paste the
previously copied node as a child of the currently selected node. The Paste option will
be enabled only when the copied node can be a child of the selected node.

You can only select one tag each for the cut, copy, and paste function.

Example:

Right-click on the node you want to copy (MELSEC MEDOC plus variable, D100
AD_VALUE) to open the context menu and select copy:
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Right-click on the parent node (MAC PLC connection) in which you want to paste the
copied node. The context menu is opened. Select paste:

The node (variable D100 AD_VALUE) is added:

5.6.6 Drag and drop

Drag and drop is a simplified way of cutting, copying, and pasting.

To move a node:

a Select the node to be moved and hold down the left mouse button.

b Drag the node to the desired location.

c Release the mouse button. The node is now dropped in the new location.
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To copy a node:

a Select the node to be copied and hold down the left mouse button.

b Drag the node to the desired location.

c Hold the CTRL key and release the mouse button. The node is now dropped in the
new location.

5.7 Integrated Tag Editor

The Tag Editor is a table of all tags included in the MXChange database. The tags can
be added, edited, or deleted via the Tag Editor. Additionally, the tags can be added
to other projects or deleted from them.

A tag can be added with several attributes set automatically and with values
increasing or decreasing by different amounts each time it is added.

5.7.1 Main Tag Editor window

The main Tag Editor window lists all tags included in the MXChange database. Each
row contains one tag and the respective MXChange data. Additionally, the row
includes a list of projects to which the tags belong.
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5.7.2 Node specific data dialog

To access the node specific data dialog

n double-click on a tag entry
or

n right-click on the Tag Editor window.

The node specific data dialog contains the information for specific projects that
contain the selected MXChange tag.

If the tag is included in multiple projects of the same type, the list may contain several
columns. In this case the first 10 fields are the common MXChange fields as in the
main Tag Editor window. The next 5 fields are MELSEC MEDOC plus specific fields,
the next 6 are for ProfiMap, and the last 8 are for MX SCADA.
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5.7.3 MXChange tags

The MXChange tags contain the following fields:

MXChange name

A valid MXChange name must start with a letter and may include further letters,
numbers, underscore characters ( _ ), mathematical signs, like "+, -, *", and the space
character. The MXChange name is used to identify the tag and should describe the
use of the tag in the project(s).

Note: Several programming and configuration systems allow further characters (e.g.
national characters like â, ä, à, å) in the name. If you use such characters, make sure
that all projects dealing with the MXChange tag name can handle these characters.

Characters Examples

Characters allowed for all
configuration packages

"A...Z", "0...9", "_" ALARM, LIM_SW_5

Note: MX SCADA projects use only upper-case characters.

Data type

The data type of a tag defines the type of data collected for this tag. The following
table gives an overview of the mapping between types in each package.
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Available data types

MXChange MM+ MX block MP+ ProfiMap Range

BOOL BOOL DI/DO/DR BOOL BOOL 0 (FALSE), 1(TRUE)

BYTE - - - INT8 1 0 to 255

WORD WORD AI/AO/AR WORD UINT16 1 0 to 65535

DWORD DWORD AI/AO/AR DWORD UINT32 1 0 to 4294967295

SINT - - - INT8 -128 to 127

INT INT AI/AO/AR INT INT16 -32768 to 32767

DINT DINT AI/AO/AR DINT INT32 -2147483648 to
2147483647

USINT - - - UINT8 0 to 255

UINT WORD
INT 1

AI/AO/AR INT 1 UINT16 0 to 65535

UDINT DWORD
DINT 1

AI/AO/AR DINT 1 UINT32 0 to 4294967295

REAL REAL AI/AO/AR REAL FLOAT IEC 559

STRING STRING 2 TX 1 ASCII[ ] VISIBLE_STR P 3

TIME TIME - - - P 3

DATE - - - DATE P 3

TIME_OF
_DAY/TOD

- - - TIME OF DAY P 3

Array 4 ARRAY[ ] - - -

1 Types do not match exactly but are the closest match

2 QnA only (default value 20 characters, maximum value 255 characters)

3 Depends on implementation

4 The number of elements is specified in the Tag Editor by grouping individual tags into an ARRAY.

PLC

The name of a PLC available to MXChange (read only).

Device Address

The address of the item that the tag points to.
Example: D450

IEC Address

The address of the item that the tag points to in IEC format.
Example: %MW0.450
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I/O Bit

In case of BOOL tags each bit of a longer data type can be assigned by the I/O bit.
The value (n) of the I/O Bit is the nth bit in the longer data type.

The value can be

n in the range of 0 to 15
n or -1 to indicate no offset.

Size

The size of the data in bytes which the tag collects. The Tag Editor automatically
changes the size when the data type changes.

Elements

The number of elements of a specific data type at a specific address. For example, if
the number of elements is four, then there would be four elements of a specific data
type at this address. The elements represent an ARRAY.

Description

A comment to describe the purpose of the tag.

5.7.4 Node specific tag descriptions

In addition to the common MXChange tag data, tags may have supplementary details
in the Tag Edit Window pertaining to the different projects types:

MM+

Item Description

MM+ Variable The tag name in the MM+ project

MM+ Function Block The function block identifier

MM+ Instance The function block instance identifier

MM+ Class The tag class

MM+ Remark Supplementary comment

Available classes for MM+

Currently only VAR_GLOBAL is supported.
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ProfiMap

Item Description

ProfiMap FMS Index The FMS index of the tag

ProfiMap FMS Name The tag name in FMS

ProfiMap Device The device this tag references

ProfiMap Parent The parent tag on the device

ProfiMap Type Tag type (DP or FMS)

ProfiMap In/Out Input or output tag

MX SCADA

Item Description

MX Tag Name The tag name in the MX project

MX Scan Time The scan time for the tag

MX Low EGU The lower limit of the tag's value in MX

MX High EGU The upper limit of the tag's value in MX

MX Units The units, e.g [m/s] for analog tags

MX Open Label The open (0) label for digital tags

MX Closed Label The closed (1) label for digital tags

MX Block Type The block type in MX (Analog Input, Analog Output, ...)
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5.7.5 Filtering the Tag Editor display

To keep track of numerous MXChange tags, you can filter specific tags to be
displayed in the Tag Editor. To access the context menu, right-click on the Tag Editor
and select Options:

There are two ways to filter the tags displayed in the Tag Editor window:

n When you enter a regular expression for the required MXChange names, all
tags matching this expression will be displayed. All other tags are hidden.

n When you enter a device range, only the tags of the specified range are displayed.

Regular expressions for filtering

Regular expressions are text patterns that are used for string matching in order to
filter the displayed information. Regular expressions are strings containing text and
special characters to indicate the matching type.

The simplest regular expression is the first part of the string to match. "TRACK" e.g.,
would match all MXChange names beginning with "TRACK".

To find a digit, the regular expression to search for is "[0-9]". The brackets indicate
that the digits being compared match any of the digits enclosed in the brackets.
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The dash (-) between 0 and 9 indicates that it is a range from 0 to 9. Therefore, this
regular expression will match any character between 0 and 9, that is, any digit. If you
want to search for a special character, use a backslash in front of the special
character. For example, the single character regular expression "\*" matches a single
asterisk.

In the table below the special characters which can be used in strings are briefly
described.

Examples:

TRACK Matches all tag names beginning with "TRACK"
.*POS Matches all tag names containing "POS" anywhere
.*A.*2.* Matches all tags containing "A" followed by "2"
TAG_1[0-2][0-9] Matches TAG_100 to TAG_129 inclusive
[P|D] Matches tags starting with "P" or "D"
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^ Beginning of the string. The expression "^A" will match ‘A’ only at the beginning of the
string.

^
The caret (^) immediately following the left-bracket ([) is used to exclude the remaining
characters within brackets from matching the target string. The expression "[^0-9]"
indicates that the target character should not be a digit.

$ The dollar sign ($) will match the end of the string. The expression "abc$" will match the
sub-string "abc" only if it is at the end of the string.

| The alternation character (|) allows either expression on its side to match the target string.
The expression "a|b" will match ‘a’ as well as ‘b’.

. The dot (.) will match any character.

* The asterix (*) indicates that the character to the left of the asterix in the expression should
match 0 or more times.

+ The plus (+) is similar to asterix but there should be at least one match of the character to
the left of the + sign in the expression.

? The question mark (?) matches the character to its left 0 or 1 times.

( )
The parenthesis affects the order of pattern evaluation and also serves as a tagged
expression that can be used when replacing the matched sub-string with another
expression.

[ ] Brackets ([ and ]) enclosing a set of characters indicate that any of the enclosed characters
may match the target character.



Example:

a Right-click on the Tag Editor to access the context menu.

b Select Options.

c Open the Filters dialog.

d Enter the desired expression, e.g. ".*POS" for any tag name containing the string
"POS".

e Check the Enabled box.

f Click on .

g The Tag Editor now lists only matching entries:

h To deactivate any filter, uncheck the Enabled box in the Options/Filters dialog.
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Note: The filter distinguishes upper-case and lower-case characters within the
expressions to be matched.

Do not forget to check the Enabled box in the Filter dialog.
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5.7.6 Automatic tag entry

When adding a series of similar MXChange tags, a number of patterns can be filled
automatically. To set up automatic tag entry, click on the Options button. Now,
the automatic tag entry dialog box opens. The automatic tag entry dialog box gives a
list of the available projects and the relevant fields. From these projects you can select
the tag entries.

The list of available projects is on the left. The patterns valid for the selected projects
is on the right.

The Enabled checkbox specifies whether automatic tag entry is enabled for the next
tag(s) to be entered.

When the checkbox Show all fields is enabled, all patterns valid for the selected
project are displayed. When this checkbox is not enabled, click the Add / Remove
Patterns button to use the Select Patterns dialog.

When the checkbox Continue from previous is enabled, the counter is continued
from the last tag which has been added. If 30 tags have been added and one field
needs to be changed, the counter will restart from 31.
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The Restrict common fields to shortest length checkbox ensures that different
project types contain the same data by truncating the data to the maximum length of
the shortest field.

There are two types of automatic data: static and dynamic.

Static data remains the same for every tag created with the automatic tag entry
enabled. This is useful for setting the PLC.

Dynamic data changes for each new tag based on the patterns entered.

The patterns have the following form:

<Start:Finish:Step>

Start is the first numeric value to be replaced.
Finish is the last numeric value to be replaced.
Step is the number to be added to or subtracted from the previously added tag.

Example:

The pattern "New_Tag_<1:20:1>_A" was entered into the MXChange name field,
when adding a new tag.

"New_Tag_1_A"

appears in the MXChange Name field in the main Tag Editor window. The next tags
are "New_Tag_2_A", "New_Tag_3_A" etc. The last tag is "New_Tag_20_A".
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5.7.7 Selecting patterns for automatic tag entry

The Select Patterns dialog is used to select which patterns are to be displayed in the
automatic tag entry dialog.

The list on the right shows the list of patterns currently included in the Automatic
Tag Entry. To add patterns, select the patterns in the left list containing the excluded
patterns and click Add. To remove patterns, select the patterns in the right list and
click Remove.
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5.7.8 Tag Editor context menu

To access the Tag Editor context menu, right-click on the Tag Editor window.

5.7.9 Tag operations

The Tag Editor supports the following tag operations.

Add a new tag

To add a new tag to the database, right-click on the Tag Editor window and select
Add MXChange Tag.

This will insert a blank line (depending on the automatic tag entry settings), in which
the details of the new tag can be typed. For more information on the tag data, refer
to the section MXChange tags on page 5-28.

Save tag(s)

Depending on the user preferences, there are different ways to save tags:

n Save modifications automatically
The modified node is saved when the cursor is moved off the current row.

n Save MXChange tag
To save an MXChange tag, select Save MXChange Tag from the context menu.

n Save all MXChange tags
To save all modified MXChange tags, select Save all MXChange Tags from the
File menu or the context menu.

n Save selected tags
To save selected tags, select a range of tags and select Save MXChange Tag
from the context menu.

Edit an existing tag

To edit an existing tag, type the corrections into the Tag Editor window.
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Edit node specific details

To edit the node specific details of a tag,

n double-click on the tag,
n or right-click on the tag and select Edit MXChange Tag,
n or press §E.

Then the node specific data dialog box appears. Enter the changes into the dialog
box and click to save the changes.

Delete an existing tag

To delete an existing tag

n right-click on the tag and select Delete MXChange Tag
n or press §D.

After confirmation, the tag will be deleted.

Add a tag to a project

There are several ways to add a tag to a project:

n Click the right mouse button on the tag and select Add MXChange tag to
project. A sub-menu will appear including a list of the projects available for this
tag.

n Double-click the left mouse button on the corresponding tag and project field. The
tag and project field is where the row containing the tag and the column
containing the project intersect. If this field contains the value 0, then the tag will
be added.

n Type the value 1 into the corresponding tag and project field.

To add multiple tags to a project, select a range of tags and right-click on the Tag
Editor window. Select the project from the Add MXChange tags to project
sub-menu. The tags will be added with default values for the project specific data.

Delete a tag from a project

There are several ways to delete a tag from a project:

n Click the right mouse button on the tag and select Delete MXChange Tag from
Project. A sub-menu will appear including a list of the projects containing this tag.

n Double-click the left mouse button on the corresponding tag and project field. The
tag and project field is where the row containing the tag and the column
containing the project intersect. If this field contains the value 1 or higher, then
the tag will be deleted.

n Type the value 0 into the corresponding tag and project field.
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5.7.10 Multiple tag selection

Select more than one row in the Tag Editor window

There are several ways to select more than one row in the Tag Editor window:

n Click in the leftmost column (the one without heading) and drag the mouse up or
down. The selected tags change to an inverted image.

n Alternatively, click in the left column of the first tag, hold the ¨ key down, and
click in the left column of the second tag.

n To select more than one block, hold down the § key and click on the rows to be
selected.

To deselect the tags, click anywhere in the Tag Editor window but not in the leftmost
column.

For the following operations it is possible to select multiple tags by clicking on the
context sensitive menu of the Tag Editor window.

n Save
n Delete
n Add to project
n Delete from project

5.7.11 Sorting tags

To sort the tags by a specific column, click on the heading of the respective column.
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5.8 Server database operations

The MXChange server is capable of managing several databases. These databases
must be located on the same personal computer as the server itself in the directory:

C:\Program Files\MelSoft\MXChange\Database

The following items are included in the File menu:

5.8.1 New

This option prompts for a file name.

If the file name does not already exist, the server creates a new database with this
name. The current database on the server is closed. The new database is loaded and
displayed in the main window.

Password protection

Each database is protected by an individual password.

The password of the database that was opened when you selected the File/New
command will be inherited to the new database.

If there was no database opened when you selected the File/New command, the
new database will be given the default password. The default password is "" (leave it
blank). In this case you will be prompted for the password before the new database
is displayed. Leave the password entry blank and confirm with OK.
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Note: The server and user name cannot be entered because here only the password
for the new database to be displayed is requested.

5.8.2 Open

This option provides a list of available databases.

Select a database and click . The contents of the current window(s) will be
replaced by the opened database's nodes.

Where necessary, you will be prompted for the password of the database to be
opened.

5.8.3 Save As

This option prompts for a database name.

If the database name does not exist, a new database will be created including the
contents of the existing database. This new database will be loaded.

5.8.4 Close

This option closes the current database.

5.8.5 Delete

This option closes and deletes the current database.
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5.9 Changing user preferences

5.9.1 Changing the user password

Each common database is protected by an individual password. To change the
password, select Change Password from the File menu. The following dialog box
appears:

The default password is "" (leave it blank).

Enter all required information.

Click , the server changes the password. If the old password is incorrect, the
password will remain unchanged.
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5.9.2 Changing display preferences

To change display preferences, select Preferences... from the File menu. A dialog
box with three tabs appears. The Edit tab presents the following options:

Address display format

The Address display format displays the tag location within the PLC. The location
can be displayed in MM+ format, IEC format, or in both formats.
Default: IEC address at first

Icons

Icons in the main project window can be large (32x32), small (16x16), or they are
omitted completely.
Default: Large

Automatically save grid row edits

When editing tags in the Tag Editor window, the current tag can be saved as soon as
you leave the current row. To enable this, check the respective box. If the box is not
checked, the new or modified tags must be saved explicitly.
Default: Enabled
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Background tree expansion

If background tree expansion is enabled, the Super Project Manager will wait for a
gap between instructions and then fetch details of the tags from the server. This
reduces time necessary to expand tags in the main project windows, as the details
have already been found. Preferences will be changed only in the current window,
but the new values will be stored and used as the initial values for any subsequent
connections.
Default: Enabled

Show tags in automation project navigator

To reduce the size of the automation project navigator, the tags can be hidden. The
tags will still be visible in the Tag Editor window. To hide the tags in the automation
project navigator, disable this option.
Default: Enabled

Filter tags by node selection

To reduce the size of the Tag Editor window, the tags can be filtered according to the
project selected in the hierarchy pane. When selecting a project in the hierarchy pane,
the tags not contained in that project will be removed from the Tag Editor
window. Previously hidden tags which are contained in that project will be restored to
the Tag Editor window view. If a node which is not a project is selected in the
automation project navigator, the project to which the node belongs will be chosen.
If the tag is not contained in a project, all tags will be displayed. The project used for
filtering will be displayed in the status bar.
Default: Enabled

5.9.3 View

When selecting Toolbar or Status Bar from the View menu the relevant control will
be toggled between hidden or displayed. The current status is indicated by a check
mark beside the menu item.

5.9.4 Arranging windows

Cascade

When selecting Cascade all the open windows in the application (project windows
and edit or add node windows) will be arranged one behind the other. The title bars
are staggered.

Tile

When selecting Tile, all open windows will be arranged and resized so that they are
all visible. They will be arranged one above the other (tile vertical) or side by side (tile
horizontal).
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5.10 Help

5.10.1 Getting help

Selecting Contents from the Help menu will bring up a browser including online
help.

5.10.2 Getting context sensitive help

To get the context sensitive help, press � or select an item via the context sensitive
help cursor. This will bring up a browser including online help. The browser will
display the relevant topic for the item. If no specific help exists for the item, the first
online help topic will be displayed.

5.10.3 About Super Project Manager

To get information on the current version of the Super Project Manager, select
About.
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6 External Tag Editor (16-bit)

The external 16-bit version of the Tag Editor is intended for personal computers
running MS Windows 3.11.

The functions and procedures are the same as described for the integrated version
within the Super Project Manager. For detailed instructions refer to the section
"Integrated Tag Editor" on page 5-26.

6.1 Running the external Tag Editor

1. Start the Tag Editor

n Double-click on the MXChange program group in the Windows Program
Manager.
The program group opens.

n Double-click on the Tag Editor 16-bit icon.
The Tag Editor starts.
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2. Login to the MXChange server

The Login dialog box appears. You can login to an MXChange server running on the
same computer or on a different one you are connected to via TCP/IP:

Enter the following fields:

Server Name: TCP/IP address of the MXChange server
(initially 127.0.0.1 for the same computer)

User Name: Admin

Password: admin

Note: The server distinguishes upper-case and lower-case characters within the user
name and password.
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3. The Tag Editor window

The tag values may be modified directly in the spreadsheet cells.

To save the changes, use the right mouse button menu. There is also an option to
save all changes automatically in the Edit tab of the options dialog (see page 5-45).

To edit a tag more detailed, double-click on the tag to display the detailed editing
dialog box.

The list may be sorted by any of the columns in any order. To sort the list click on the
heading of the column by which the list is to be sorted.

The right mouse button menu available from the spreadsheet includes options to add
a tag to a project or remove a tag from a project. This can be used to export tags
from one project into others.

To enter tags following a pattern, take the following steps:

a In the Options dialog box, select Auto Tag.

b Select one or more projects in the list.

c Click Add / Remove Patterns.

d Select MXChange Name.

e Enter a pattern, e.g. “Tag:10:1" for Tag1, Tag2, Tag3 ... Tag10. Any fields may be
added with a similar pattern format.

f Select Add Tag from the right mouse button menu and the tags will have the
details selected as patterns.
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6.2 Program exit

Click to exit the external Tag Editor.
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7 Working with Nodes in MXChange

This chapter describes how to create nodes in an automation project in MXChange.

The standard procedure to integrate projects (e.g. MELSEC MEDOC plus PLC
projects) is described in chapter 4, "Getting started".

7.1 Starting the Super Project Manager

Start the Super Project Manager and login to an MXChange server running on your
personal computer or on a different personal computer you can connect to via
TCP/IP.
For details on the login, refer to chapter 4, "Getting started".
Here the project starts showing a blank database:
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7.2 Creating a new MELSEC MEDOC plus project node

Since the complete automation project is represented as a hierarchy of nodes you
have to create a new project as new node.

1. Add a new MELSEC MEDOC plus node

To add a new MELSEC MEDOC plus node:

n Right-click on the top-level node Automation project navigator to open the
context menu.

n Select Add Node.
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2. Select node type

The Select node type dialog appears. The contents of this dialog vary depending on
the node type to which the new node is to be added. A MELSEC MEDOC plus project
always represents a PLC of a specific series.

Select the desired PLC series and confirm by clicking .
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3. Enter project specific information

The following dialog box appears:

Item Meaning

Name MXChange project name to appear in the tree;
node name (32 characters max.), normally the same as the project name.

Project name MM+ project name (8 characters max.)

Computer name Network name or TCP/IP address of the PC where the project is based

Browse Browse network for available computers

Project path Full path to the project file

Browse Browse for path

Online changes Box is checked, if online changes are required

PLC type Exact PLC type

Enter the required project specific information and confirm by clicking .
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4. New MELSEC MEDOC plus project node is created

The new MELSEC MEDOC plus project node is added to the automation project
navigator:

Note: Here you do not build up the actual MELSEC MEDOC plus project, but only the
tree structure within MXChange for a MELSEC MEDOC plus project.

For the integration of a MELSEC MEDOC plus project in MXChange:
n create a separate MELSEC MEDOC plus project with the same name, path, and

settings
n or enter the name, path, and settings of an existing MELSEC MEDOC plus project

for the MXChange node.
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5. Add a new local I/O node to the MELSEC MEDOC plus project node

To add a new local I/O node to the MELSEC MEDOC plus project node:

n Right-click on the MELSEC MEDOC plus project node to open the context menu.
n Select Add Node.
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6. Select a node type

The Select node type dialog appears. The contents of this dialog vary depending on
the node type to which the new node is to be added. The dialog below shows the
available node types for a MELSEC MEDOC plus node.

Select the desired I/O type and confirm by clicking :

7. Enter a name for the PLC local I/O

Enter a name for the PLC local I/O and confirm by clicking :
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8. New PLC local I/O is created

The new PLC local I/O in the MELSEC MEDOC plus project is created. However, it is
not yet displayed, as the MELSEC MEDOC plus project is not expanded:

9. Expand MELSEC MEDOC plus node

To expand the MELSEC MEDOC plus project, click on .

Now, the new PLC local I/O is displayed:
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10. Add a new tag to the PLC local I/O

To add a new tag to the PLC local I/O:

n Right-click on the Tag Editor window to open the context menu.
n Select Add MXChange Tag.

A blank row for the new MXChange tag will be added:

11. Edit the new MXChange tag

The new tag can be edited directly in the Tag Editor window.

Enter the required values:

The variable type can be selected from a drop-down list. The IEC address is calculated
automatically.
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12. Save the MXChange tag

To save the MXChange tag:

n Right-click on the edited tag to open the context menu.
n Select Save MXChange Tag.

When the tag has been saved, it will be referenced to the according project. The
references to different projects are indicated by the digit below the project name:

13. New tag is represented as node

In the automation project navigator the new tag is represented as child node of the
MELSEC MEDOC plus I/O node and also added to the MXChange Tags:

Click on to expand a node.
Click on to collapse a node.
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14. Configure the automatic tag entry function

When adding a series of similar MXChange tags, a number of patterns can be filled
automatically. For details see section "Automatic tag entry" on page 5-36.

To configure the automatic tag entry function:

n Right-click on the Tag Editor window to open the context menu.
n Select Options.
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n Click on the Auto Tag tab to open the following dialog.
n Select the project to be expanded.

Specify the fields to be entered automatically:

To specify the fields to be entered automatically you have two alternative choices:

A. Select all relevant fields for the automatic entry and edit the contained patterns
for these fields via the Show all fields function (see below).

or

B. Select individual patterns for the automatic entry and edit their contents via the
Add / Remove Patterns function as described below.
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Choice A.: Show all fields

To show all fields:

n Activate the checkbox Show all fields to list all fields relevant for the selected
project.

n Edit the corresponding patterns in the window shown below.

To increase or decrease automatically the numbers, the following syntax has to be
chosen:

<Start:Finish:Step>

Start is the first numeric value to be replaced.
Finish is the last numeric value to be replaced.
Step is the number to be added to or subtracted from the previously added tag.
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Choice B.: Add / Remove Patterns

To add or remove patterns:

n Click on in the Auto Tag dialog.
Now, the Select Patterns dialog opens.

n Select the required patterns for the automatic entry.

n Click on to include the selected pattern.

n Confirm your selection by clicking .
Now, you leave this dialog.

Bu
ild

in
g

N
od

es

7 – 14 Working with Nodes in MXChange

MXChange Software Manual



n Edit the selected patterns directly in the Automatic Fields section:

To enable your configuration of the automatic tag entry function:

n Ensure that the Enabled checkbox is activated.
n Click on to confirm the Auto Tag options you have configured.
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15. Add a new tag with the automatic tag entry function enabled

To add a new tag with the automatic tag entry function enabled:

n Right-click on the Tag Editor window.
The context menu opens.

n Select Add MXChange Tag.

The new tag is added including the entries in the fields selected for the automatic tag
entry function:

All further tags being added will be increased or decreased and completed
automatically.

If you want to disable the automatic tag entry function, disable the automatic tag
entry in the Options/Auto Tag dialog.Bu
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16. Save all added tags

To save all added tags:

n Right-click on the Tag Editor.
The context menu opens.

n Select Save All MXChange Tags.

17. New tags are represented as nodes

In the automation project navigator the new tags are represented as child nodes of
the MELSEC MEDOC plus project and also added to the MXChange Tags:
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18. Add a new I/O card to the MELSEC MEDOC plus project

To add a new I/O card to the MELSEC MEDOC plus project:

n Right-click on the MELSEC MEDOC plus project.
The context menu opens.

n Select Add Node.

19. Select node type

The Select node type dialog appears. The contents of this dialog vary depending on
the node type to which the new node is to be added.

Select the desired I/O card. Confirm by clicking :
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20. Enter node specific information

Enter the required node specific information and confirm by clicking .

Item Meaning

Name Node name

Slot number Slot number in the PLC

TCP/IP address TCP/IP address of the card

Port no. Port number to connect the card to

Note: If you intend to connect a MELSEC MEDOC plus project and an MX SCADA
project, ensure that the I/O card of the MELSEC MEDOC plus project corresponds to
the MX driver and the respective channel and device of the MX SCADA project.
The driver, channel, and device of the MX SCADA project must be added manually to
MXChange.
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21. New I/O point is created as node

The new TCP/IP connection is created and displayed as new node in the automation
project navigator.

The screen below shows the complete MELSEC MEDOC plus project.
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7.3 Creating a new MAC Programmer+ project node

In the following the creation of a new MAC Programmer+ project node is described.

1. Add a new MAC Programmer+ project node

To add a new MAC Programmer+ project node:

n Right-click on the top-level node Automation project navigator.
The context menu opens.

n Select Add Node.

2. Select node type

The Select node type dialog appears. The contents of this dialog vary depending on
the node type to which the new node is to be added.

Select the MP+ project and confirm by clicking :
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3. Enter project specific information

The following dialog box appears:

Item Meaning

Name Node name

Project name MP+ project name

Computer name Network name or TCP/IP address of the PC where the project is based

Browse Browse network for available computers

Project path Full path to the project file

Browse Browse for path

Online changes Box is checked, if online changes are required

Terminal type Terminal type being configured

PLC type Exact PLC type connected

Enter the required project specific information and confirm by clicking .
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4. New MAC Programmer+ project is created

The new MAC Programmer+ project is added to the automation project navigator:
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5. Add a new MAC PLC connection to the MAC Programmer+ project

To add a new MAC PLC connection to the MAC Programmer+ project:

n Right-click on the MAC Programmer+ project.
The context menu opens.

n Select Add Node.
The dialog Adding "MAC PLC connection" appears:

Item Meaning

Name Node name

Connection type Connection type to the PLC

PLC PLC containing the data

n Enter the node specific information.
The connection type and PLC can be selected from drop-down lists.

n Confirm by clicking .
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6. New MAC PLC connection is created

The new MAC PLC connection is added to the automation project navigator:
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7. Add MXChange tag to MAC Programmer+ project

To add an MXChange tag to the MAC Programmer+ project:

n Right-click on the MXChange tag you want to add to the MAC Programmer+
project.
The context menu opens.

n Select Add MXChange Tag to Project.

All projects to which the MXChange tag does not refer are listed. In the example
above the MXChange tag SET_POINT does not refer to the MAC Programmer+
project. To add the selected tag to a certain project, click on this project.

n Click on MAC_Programmer

When the tag has been added, it will be referenced to the according project. The
references to different projects are indicated by the digit below the project name:
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8. New tag is represented as node

In the automation project navigator the new tag is represented as a child node of the
MAC PLC connection. The screen below shows the MAC Programmer+ project.
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7.4 Creating a new MX SCADA project node

In the following the creation of a new MX SCADA project node is described.

1. Add a new MX SCADA node

To add a new MX SCADA node:

n Right-click on the top level node Automation project navigator.
The context menu opens.

n Select Add Node.

2. Select node type

The Select node type dialog appears. The contents of this dialog vary depending on
the node type to which the new node is to be added. Select the MX project and
confirm by clicking :
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3. Enter project specific information

The following dialog box appears:

Item Meaning

Name Node name

Computer name Network name or TCP/IP address of the PC where the project is based

Browse Browse network for available computers

MX base path Base path of the MX directory

Browse Browse for path

SCU file Full path and file name of the system configuration file

Browse Browse for path

Online changes Box is checked, if online changes are required

MX version Version of MX

MX node name Network name for this MX node

Database name Full path and file name of the process database (PDB) file

Database serial
no.

Serial number of database

Enter the required project specific information and confirm by clicking .
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4. New MX SCADA project is created

The new MX SCADA project is added to the automation project navigator:
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5. Add a new driver to the MX SCADA project

To add a new driver to the MX SCADA project:

n Right-click on the MX SCADA project.
The context menu opens.

n Select Add Node.
The Select node type dialog appears.

The contents of this dialog vary depending on the node type to which the new node
is to be added. Select a driver type and confirm by clicking :

6. Enter node specific information

The following dialog box appears:

Enter the driver name and confirm by clicking .
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7. New driver node is created

The new driver in the MX SCADA project is created. In this case it is an MQE driver.
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8. Add a new MQE channel

To add a new MQE channel:

n Right-click on the MQE driver node.
The context menu opens.

n Select Add Node.
The dialog Adding "MQE channel" appears.

Enter the node specific information and confirm by clicking .
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9. New MQE channel node is created

The new MQE channel in the MX SCADA project is created:
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10. Add a new MQE device

To add a new MQE device:

n Right-click on the MQE channel node.
The context menu opens.

n Select Add Node.

The dialog Adding "MQE device" appears:

Item Meaning

Name Device name (included in the I/O record)

Description Device description

CPU type Type of CPU to which the device is connected

Protocol Protocol to use

TCP/IP address Primary TCP/IP address to which the driver is connected

TCP/IP port TCP/IP port at the primary address

PLC address PLC address to which the driver is connected (0-64: slave, 255: master)

Card type I/O card type in the PLC

Network number Network number (0-239)

Poll type Poll type (polled or unsolicited)

Enter the node specific information. The CPU type, protocol, card type, network
number, and poll type can be selected from drop-down lists. Confirm by clicking

.
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Note: If you intend to connect a MELSEC MEDOC plus project and an MX SCADA
project, ensure that the I/O card of the MELSEC MEDOC plus project corresponds to
the MX driver and the respective channel and device of the MX SCADA project.
The driver, channel, and device of the MX SCADA project must be added manually to
MXChange.

11. New MQE device node is created

The new MQE device node in the MX SCADA project is created:

Bu
ild

in
g

N
od

es

7 – 36 Working with Nodes in MXChange

MXChange Software Manual



12. Add MXChange tag to MX SCADA project

To add an MXChange tag to MX SCADA project:

n Right-click in the Tag Editor on the MXChange tag you want to add to the MX
SCADA project.
The context menu opens.

n Select Add MXChange Tag to Project.

All projects to which the MXChange tag does not refer are listed. In the example
above the MXChange tag SET_POINT does not refer to the MX SCADA project. To
add the selected tag to a certain project, click on this project.

n Click on MX-HMI_SCADA
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13. Edit MX SCADA tag

The MXChange Tag Edit Window opens automatically:

Edit the project specific information and confirm by clicking .

14. Tag is referenced to the MX SCADA project

When the tag has been added, it will be referenced to the according project. The
references to different projects are indicated by the digit below the project name:Bu
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15. MX SCADA tag is represented as node

In the automation project navigator the MX SCADA tag is represented as a child node
of the MQE device. The screen below shows the complete MX SCADA project.
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7.5 Overview of the complete automation project tree
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7.6 Editing nodes

To edit nodes:

n Right-click on the node to be edited.
The automation project navigator context menu opens.

n Select Edit Node.
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The Editing node dialog appears. In the example shown below a MELSEC MEDOC
plus project node is edited:

The entries available for editing depend on the node type which has been selected.

Edit node dialog items:

Item Meaning

Name MXChange project name to appear in the tree;
node name (32 characters max.), normally the same as the project name.

Project name MM+ project name (8 characters max.)

Computer name Network name or TCP/IP address of the PC where the project is based

Project path Full path to the project file

Online changes Box is checked, if online changes are required

PLC type Exact PLC type
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7.7 Editing tags

To edit tags:

n Edit the entries in the Tag Editor grid
n or right-click on the tag to be edited to open the Tag Editor context menu and

select Edit MXChange Tag:
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The MXChange Tag Edit Window appears. In the example shown below a MELSEC
MEDOC plus variable is edited:

The entries available for editing depend on the node type which has been selected.

Edit Tag dialog items:

Item Meaning

MXChange Name Variable name in MXChange

Type I/O type

PLC MM+ PLC/project name

Device Address Device address of the variable (MITSUBISHI format)

IEC Address Device address of the variable (IEC format)

I/O Bit I/O bit within an analog word or -1

Size Size of elements for an array

Elements Number of elements for an array

Description Variable description

MM+ Variable Variable name in MM+

MM+ Function
Block

Function block name in MM+

MM+ Instance Function block instance in MM+

MM+ Class Variable class in MM+

MM+ Remark Additional comment in MM+
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Note: Do not forget to save your individual automation project to get the changes
made in MXChange.
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8 Common Database Synchronisation

8.1 Synchronisation and consistency mechanism

The configuration programs process changes when starting up, saving, and optionally
during normal operation.

There are six flags for every node where a change is relevant to one of the
configuration programs. Two flags each are set for adding, deleting, or changing.
One flag indicates that the change occurred, the other indicates that it has not yet
been processed. When an MXChange tag is added, deleted, or changed, the
appropriate flags are set.

Every configuration program provides an Online Updates feature for MXChange
which can be enabled or disabled for any project. If you have enabled online updates,
the target configuration program does the change immediately and clears the
acknowledge flag. When the configuration is saved - including the changes - the
other flag will also be cleared. If the system is shut down although the database has
not been saved, the acknowledge flag is set again, so that the change can be retried.
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Sequence of a program which does not accept online updates:

a Change tag
A configuration program changes a tag, confirms the change (e.g. by saving the
database in MELSEC MEDOC plus), and passes the details to the MXChange
server.

b Set change flag and acknowledge flag
The MXChange server sets the change flag and the acknowledge flag for all other
configuration programs using the tag.

c Check online updates flag
The MXChange server checks the online updates flag of the other configuration
programs. Since none of the configuration programs is configured for online
updates, no action has to be taken.

d Check change flag and acknowledge flag, process changes
When the other configuration program saves its own database, it will check
whether changes have been done on the MXChange server. When the change
flag and the acknowledge flag for a specific tag have been set, the configuration
program will modify the tag and save its own database again to import the new
changes.

e Clear change flag and acknowledge flag
When the database has been changed, the configuration program will clear the
change flag and the acknowledge flag.
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Sequence of a program which does accept online changes:

a Change tag
A configuration program changes a tag and confirms the changes. The details are
passed to the MXChange server.

b Set change flag and acknowledge flag
The MXChange server sets the change flag and the acknowledge flag for all other
configuration programs using the tag.

c Check online updates flag and notify of changes
The MXChange server checks the online updates flag of the other configuration
programs. If one of the running configuration programs is configured for online
updates, it sends a message to the respective configuration program.

d Check change flag and acknowledge flag, process changes, clear
acknowledge flag
When receiving the message from the MXChange server, the configuration
program looks for changed tags. If the configuration program finds tags which
have been changed, it clears the acknowledge flag, but not the change flag. The
changes cannot be saved automatically.

e Clear change flag
When the user saves the database, the change flag is cleared. Sy
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Sequence from stage 5 if the database has not been saved:

e Quit without saving
The user exits the program without saving.

f Set acknowledge flag again
The MXChange server notes that the configuration program has been
disconnected and that the change flag has not been cleared. It sets the
acknowledge flag again, so that the configuration program can try again to save
the change, when it is running again.

There are separate flags for addition, deletion, and change, all used in the manner
described above. The flags are processed in the following order: delete, add, change.
This is important when a tag is deleted, then another tag is added with the same
MXChange name before all configuration programs have deleted the respective tag.
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8.2 Synchronisation mechanism of offline changes

It must be possible that programming and configuration programs change tags while
the server is down. For this reason, programming and configuration programs
maintain a local database of the connections between MXChange tags and their own
tags. If an application tag also included in MXChange is changed, added, or deleted
while the MXChange server is down, the application stores the changes locally. The
calls which would have been made for the changes if the MXChange server had been
up, are made when the MXChange server returns. As each application has its own
way to process changes, this is a function of the according application.

This way any project can be edited offline and synchronised with the common
database later.

Note: If the MXChange server is not available, the MXChange interface Tag Editor
and Super Project Manager will not run. They will terminate returning an error
message. They are so reliant on the information provided by the MXChange server
that there would be no benefit in running them when it is unavailable. Sy
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A Appendix

A.1 Toolbar items

Login

Logout

New database

Open database

Save database as

Change password

Change preferences

Add node

Refresh view

New window

Cascade windows

Tile windows vertically

Tile windows horizontally

Context sensitive help

About box
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A.2 MXChange interface error messages

Error Code Meaning Description Causes Actions

INT 0010 No failure code;
indicates that more
data is available

More data is
available from the
last operation.

This message should not appear - it
should be processed internally by the
calling application.

If the problem
persists, contact
the application
vendor.

INT 0020 The operation has
not finished

The MXChange
server has not yet
responded to the
client.

This message should not appear; it
should be processed internally by the
application.

If the problem
persists, contact
the application
vendor.

INT 0030 The action cannot
be performed
because one or
more objects are
locked by another
entity

An object could
not be accessed
because it is in use
and "locked" by
another
application.

Another application or Super Project
Manager is using the object.

Find which
application is using
the object, then try
again later.

INT 0040 General failure A general failure
occurred

This error often occurs when the system
is severely low in memory. There could
be an internal error in the calling
program.

Make sure that the
system has enough
free memory to
perform the
operation. If the
problem persists,
contact the
application vendor.

INT 0050 An attempt was
made to add an
item which already
exists

It was not possible
to add an item
because another
item exists with the
same name.

This could occur when an attempt is
made to add a tag to the system with
the same name as an existing tag.

Change the name
of the object which
was being added
and try again.

INT 0060 An object cannot
be removed
because there are
other references to
it in the system, or
its child nodes
must be removed
first.

An attempt was
made to delete an
item on which
other items depend

There could have been an attempt to
remove a parent node whose child
nodes still exist or an attempt to remove
a device which is needed by other I/O
references.

Look for any items
which are
dependent on the
deleted item, and
remove them first.

INT 0070 The requested
object does not
exist

The system could
not find the object
referred to.

The object might not exist or might have
been deleted elsewhere.

Ensure that the
object still exists,
and that it is being
referred to by the
correct name.

INT 0080 An object name is
too long or
contains invalid
characters

A name supplied
was not acceptable
regarding object
naming
conventions.

The name could be too long or could
contain invalid characters.

Try again with a
shorter, simpler
name.

A – 2 Appendix

MXChange Software Manual



Error Code Meaning Description Causes Actions

INT 0090 One or more
parameters is/are
outside the legal
range

One or more
parameters had an
unacceptable
value.

There might be an impossible value or
the value might not fit with the details
of another configuration part.

Check that the
value is within
limits and does not
conflict with other
system parts, then
try again.

INT 0095 The server has no
current database.

The database used
by the server was
closed and another
one has not been
opened.

The database was closed, probably from
the Super Project Manager menu.

Use Super Project
Manager to open
another database
file, then try again.

INT 0100 Not logged in, or
insufficient rights
to perform the
action

An attempt was
made to perform
an action which
requires rights the
current user does
not have.

Either no user is logged in or the current
user does not have a high enough
access level.

Make sure that you
are logged in. If
you are, try logging
in as a higher-level
user and try again.

INT 0110 User cancelled
operation

The operation was
cancelled.

The operation was taking too long and
was cancelled.

None

INT 0120 The call failed
because it timed
out.

The call was
abandoned
because there was
no response from
the server within a
reasonable time.

The connection to the server has been
lost due to network failure. The server is
no longer running. The link to the server
is slow, and responses are arriving too
late.

Make sure that the
network link is
working. Make
sure that the server
is still running.
Increase the server
timeout settings in
the registry or INI
file.

INT 0130 The call failed
because the link is
down.

The link to the
server was lost.

The connection to the server has been
lost due to network failure. The server is
no longer running.

Make sure that the
network link is
working and that
the server is still
running.

INT 0250 Service no.
mismatch

The type of request
sent to the server
does not match the
response type
received.

This could be due to a network error or
an application error.

If the problem
persists, contact
the application
vendor.

INT 0251 Call type changed The call type was
changed between
the request sent to
the server and the
response.

This is an internal error. If the problem
persists, contact
the application
vendor.

INT 0252 Synchronous
request not
complete

A synchronous
request had not
completed

This is an internal error. If the problem
persists, contact
the application
vendor.
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INT 0253 Unknown serial
number

A request is
missing

This is an internal error. If the problem
persists, contact
the application
vendor.

INT 0254 Synchronous / no
buffer / no serial

A synchronous call
was made without
enough space for
the results and
serial number.

This is an internal error. If the problem
persists, contact
the application
vendor.

INT 0255 Failed to allocate
request

It was not possible
to allocate a
request

The system is probably low in memory. Check whether
enough memory is
available.

INT 0256 Asynchronous call
without serial
number

An asynchronous
call was made
without serial
number

This is an internal error. If the problem
persists, contact
the application
vendor.

INT 0257 Cancel for
unidentified
request

An attempt was
made to cancel an
unidentified
request.

This error should not appear. It could be
that the request had already been
cancelled.

None

INT 0258 Problem freeing
request

It was not possible
to free a request
which had
completed.

This is an internal error due to low
memory.

If the problem
persists, contact
the application
vendor.

INT 0259 Bad call type An invalid call type
was passed to the
MXChange API

This is an internal error. If the problem
persists, contact
the application
vendor.

INT 0260 Failed to allocate
buffer

It was not possible
to allocate the
required buffer.

The system is probably low in memory. Free some
memory, then try
the action again.

INT 0261 Unexpected buffer
allocation

A buffer was
allocated although
it was not
expected.

This is an internal error. If the problem
persists, contact
the application
vendor.

INT 0262 Wrong buffer size
allocated

The wrong buffer
size was allocated.

This is an internal error which should not
occur.

If the problem
persists, contact
the application
vendor.

INT 0263 Data unexpectedly
returned

More data than
expected was
returned from a
request .

This could be a network problem or an
internal error.

If the problem
persists, contact
the application
vendor.

INT 0264 The wrong amount
of data was
returned.

The wrong amount
of data was
returned from a
request.

This could be a network problem or an
internal error.

If the problem
persists, contact
the application
vendor.
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INT 0265 Data missing Data was required
but no answer was
returned.

This is probably an internal error. If the problem
persists, contact
the application
vendor.

INT 0266 Buffer size but no
pointer

A buffer size for
returned data was
provided, but
without pointer for
the data.

This is an internal error. If the problem
persists, contact
the application
vendor.

INT 0267 No data provided No data was
passed to an API
call where it was
required.

This is an internal error. If the problem
persists, contact
the application
vendor.

INT 0268 Null or empty
nodes list

A function which
needed a list of
nodes was not
passed.

This is a problem concerning the calling
application.

If the problem
persists, contact
the application
vendor.

INT 0269 Blank server or
project name

An attempt was
made to connect
to a server without
server or project
details.

This is a problem concerning the calling
application.

If the problem
persists, contact
the application
vendor.

INT 0270 Invalid specific data
size

An invalid size was
provided for class
specific data.

This is a problem concerning the calling
application.

If the problem
persists, contact
the application
vendor.

INT 0271 A required
parameter was
blank

An API call without
required parameter
was made.

This is a problem concerning the calling
application.

If the problem
persists, contact
the application
vendor.

INT 0272 Failed to start Tag
Editor

It was not possible
to start the Tag
Editor.

A required file (e.g. TagEdit.dll or
Tag16.exe) is missing or not in the path.
There might be not enough memory to
start the program.

Make sure that the
required files are
installed and that
they are in the
path. Free some
memory and try
again.
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A.3 Server error messages

Error Code Meaning Description Causes Actions

SVR 1000 Blank project name A connection could
not be established
because no project
name was
specified.

An attempt was made to connect a
project (MM+, MX32 etc.) to the
MXChange server without specifying the
project name.

Make sure that a
valid project is
available in the
calling application.
If the problem
persists, contact
the application
vendor.

SVR 1001 Project name ...
was not found

A connection could
not be established
because the project
name was not
found in the
database.

An attempt was made to connect a
project (MM+, MX32 etc.) to the
MXChange server but the specified
project name was not found.

The project name
might be spelt
wrongly, or it does
not exist on this
server.

SVR 1002 PLC node ID was
not found

A list of references
to an MXChange
tag could not be
constructed,
because there was
no associated PLC
reference.

While getting a list of projects, which
use a specified MXChange tag, the PLC
could not be read.

This could be due
to a problem with
the database
configuration. If
the problem
persists, contact
the application
vendor.

SVR 1003 Parent node ID was
not found

A list of references
to an MXChange
tag could not be
constructed,
because its parent
node could not be
found in the
database hierarchy.

While getting a list of projects, which
use a specified MXChange tag, the
parent tag could not be read.

This might be
caused by a
problem
concerning the
database
configuration. If
the problem
persists, contact
the application
vendor.

SVR 1004 MXChange tag
name was not
found

An operation on an
MXChange tag
could not be
completed,
because the tag
could not be found
in the database.

The specified MXChange tag could not
be found in the database.

The tag name
might be spelt
wrongly or it does
not exist.

SVR 1005 Not all nodes
found

Only part of the
requested data (for
projects relating to
an MXChange tag)
could be found in
the database.

A list of nodes was requested, but only
part could be found.

If the problem
persists, contact
the application
vendor.
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SVR 1006 First node does not
exist

A list of hierarchical
information was
retreived from the
database, but the
first item is invalid
or has been
deleted.

The item to fetch has been deleted or
does not exist.

Try the operation
again. If the
problem persists,
contact the
application vendor.

SVR 1007 Database query
failed

A request for
infomation from
the database
subsystem has
failed.

The server tried to fetch data from the
database, but it failed.

This could be
caused by an error
in the data passed
to the server. If the
problem persists,
contact the
application vendor.

SVR 1008 Parent node ID ...
was not found

The parent node of
this node could not
be found in the
database hierarchy.

The position where the node should be
added cannot be found.

Ensure that the
position where the
item should be
added exists. Try
the operation
again.

SVR 1009 Absolute level of
parent ... does not
match level of this
node ...

The node could not
be added to the
database because
the requested level
is not compatible
with the parent.

When adding a node, the absolute level
does not match the level of the parent
node (e.g. the absolute level is two
levels below the level of the parent
node).

Supply the correct
level.
Try the operation
again.

SVR 1010 Insufficient access
level to add nodes
of class ...

You do not have
the correct access
level to add this
information class.

The following causes are possible:
- You are not logged in.
- You have to log in at a higher access

level to add this node class.
- It is not possible to add this node class.

Log in (at a higher
access level if
necessary). Try the
operation again.

SVR 1011 Unable to create
node ...,
parent ID ...

The database entry
could not be
created.

Each database node stores extra
information dependent on its type. The
amount of data supplied did not match
the amount expected for the type of
node.

If the problem
persists, contact
the application
vendor.

SVR 1012 Node ID ... was not
found

The given node
identifier could not
be found in the
database.

The node ID can be incorrect or the
node can have been deleted.

Ensure that the
node ID still exists
in the database.

SVR 1013 Insufficient access
level to modify
node ... of class ...

The user does not
have the correct
access level to
modify information
of this class.

The following causes are possible:
- You are not logged in.
- You have to log in at a higher access

level to add this node class.
- It is not possible to modify this node

class.

Log in (at a higher
access level if
necessary) and try
the operation
again.
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SVR 1014 The data size for
class ... is incorrect
(expected ..., got
...)

The operation
could not be
completed,
because the data
size does not
match the size
expected for this
information type.

Each node in the database stores a
certain amount of data. While trying to
modify a node, the incorrect amount of
data was supplied.

This might be
caused by a
problem
concerning the
calling application.
If the problem
persists, contact
the application
vendor.

SVR 1015 No node to delete The delete
operation failed or
the node to be
deleted could not
be found.

The node to be deleted does not exist. Ensure that the
node to be deleted
is in the database.

SVR 1016 Field name ... not
found

A value could not
be written in a
database field,
because the field
does not exist.

The field does not exist. The wrong
node has been used. Another node has
been passed which does not include the
required field.

Ensure that the
node exists and
that it has the
required field.

SVR 1017 Missing or
non-alphabetical
first character of
MXChange tag
name ...

An incorrect
MXChange tag
name was
supplied.

No MXChange tag name has been
specified. The first character in the name
is not alphabetical.

Ensure that the
first character is
valid.

SVR 1018 Invalid character ...
at position ... in
MXChange tag
name ...

The MXChange tag
name is not valid
because it includes
an illegal character.

Only alphanumeric characters are
allowed in MXChange tag names.

Change the invalid
character and try
the operation
again.

SVR 1019 No device node
found

A database entry
matching the
specified device
node could not be
found.

The server could not find an MX32
device driver for the tag to be added.
This could be because no driver is
configured to communicate with the
PLC. It was not possible to find the
ProfiMap slave where this tag should be
added.

Ensure that a
suitable
slave/device is
defined and
selected. Try the
operation again.

SVR 1020 No matching PLC
found

The PLC referenced
by the MXChange
tag has no
corresponding
entry in the
database.

While trying to add an MXChange tag to
the database, it was not possible to find
the PLC.

Ensure that the PLC
is defined and
specified correctly.
Try the operation
again.

SVR 1021 No PLC ID found A valid reference to
the specified PLC
database entry
could not be
found.

While trying to add a tag to the
database, it was not possible to identify
the PLC holding the I/O reference.

Ensure that the
details supplied
define the PLC
holding the I/O
reference.
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SVR 1022 Multiple tags found An MXChange tag
could not be added
to the database
because one with
the same identity
already exists.

The following causes are possible:
- A node is added to the hierarchy with

a name already existing.
- The maximum number of that node

type already exists, e.g. each MX
project can only have one driver node
of each type.

- There are already more than one tag
including the same details (internal
error).

- The MXChange tag to be added
already existed on the specified device.

Try to add the
node with a
different name.
Ensure that there
are not too many
nodes of the
specified type.
Check whether the
tag exists only
once. Check
whether the tag
does not already
exist on the MX
device.

SVR 1023 Parent node ... is
incorrect

An MXChange tag
could not be added
to the database
because its parent
has the wrong
type.

The MXChange tag type cannot be
added to the specified parent node.

Ensure that the
node was added at
a valid position. If
the problem
persists, contact
the application
vendor.

SVR 1024 Level has changed
several times

The MXChange tag
could not be added
because its
specified position is
incorrect.

While adding an MXChange tag, the
level to add changed several times. By
this it was impossible to find the position
where the MXChange tag should be
added.

This problem
concerns the
calling application.
If the problem
persists, contact
the application
vendor.

SVR 1025 The child node has
no parent node

The MXChange tag
could not be
added, because no
parent node was
specified.

An attempt was made to add an
MXChange tag under another
MXChange tag without specifying the
parent tag.

This problem
concerns the
calling application.
If the problem
persists, contact
the application
vendor.

SVR 1026 Missing project ID
...

The project could
not be found.

The project does not exist or it has been
deleted.

Ensure that all the
projects exist. Try
the operation
again.

SVR 1027 No child nodes
found

The node in the
database hierarchy
should have child
nodes but it has
not any.

An attempt was made to add a child
MM+ tag without specifying the parent
node. An MM+ project does not have a
local I/O node.

Ensure that the
parent node is
specified correctly.
Check whether the
MM+ project has a
local I/O node (and
add one if
necessary).
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SVR 1028 Unable to add
node to database

The node could not
be added to the
database.

There will be a secondary error message
giving more details.

Look at the
secondary error
messages to
determine the
action to take.

SVR 1029 Missing DP parent The specified DP
parent does not
exist in the
database.

While adding a ProfiMap DP tag, it was
not possible to find the specified parent
tag. While adding ProfiMap DP tags
based on level, no parent could be
found for the specified level.

Check whether a
valid parent node is
specified. Try the
operation again.

SVR 1030 DP node level does
not match level
supplied from DP
parent

The entry cannot
be added to the
database, because
its DP parent has
the wrong level.

When adding a ProfiMap DP node and
specifying the parent node directly, the
level of the specified parent node does
not match the tag level.

Check whether the
level and parent
nodes are valid. Try
the operation
again.

SVR 1031 Level has jumped
forward while
trying to add DP
node

No parent was
specified, but the
current level is
incorrect.

While adding a number of DP tags
based on level, a level has been left out.

Check whether
each tag is only
one level deeper
than the previous
tag.

SVR 1032 Cannot add
because no
ProfiMap slave
exists with range
containing ...

The MXChange tag
cannot be added to
the database,
because the
specified I/O range
is not within the
range of an
existing slave.

The address is incorrect or a new slave
must be added.

Correct the address
or add another
slave.

SVR 1033 The slave specified
does not match the
calculated slave for
new ProfiMap DP
tag

The slave
calculated from the
parent or level
does not match the
specified slave .

The ProfiMap slave was specified and
also calculated from the details supplied
(address etc.). But the specified slave
and the calculated slave do not match.

Check whether the
supplied slave is
suitable. If
necessary, try to
add the tag
without specifying
a slave. By this the
server can calculate
the most suitable
slave automatically.

SVR 1034 Missing I/O node
under DP slave ...

The tag cannot be
added because no
local I/O
information was
found under the
DP slave.

The local I/O node was not added or has
been deleted.

Add a local I/O
node under the
ProfiMap DP slave
using Super Project
Manager.

SVR 1035 Missing FMS parent The specified FMS
parent is missing.

The specified FMS parent does not exist. Correct the parent
details. Try the
operation again.
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SVR 1036 FMS node level
does not match
level supplied from
parent

The supplied FMS
node level does not
match the level
from the parent.

An FMS parent tag and the
corresponding FMS node level were
specified. The level is incompatible with
the level of the parent FMS node.

Correct the parent
node or the level.
Try the operation
again.

SVR 1037 Level has jumped
forward while
trying to add FMS
node

No parent was
specified, but the
current level is
incorrect.

While adding several ProfiMap FMS tags,
the depth of a tag increased by more
than one. By this it became impossible
to assign a parent node.

Check whether
each tag is only
one level deeper
than the previous
tag.

SVR 1038 No matching slave
name for FMS tags

No appropriate
slave name was
found for FMS tag.

While adding a ProfiMap FMS tag, a
slave was specified. This slave could not
be found.

Ensure that the
name is spelt
correctly and that
the slave exists.

SVR 1039 Missing MP+ I/O
card

The tag cannot be
added because no
appropriate PLC
connection was
found.

While trying to add a tag to an MP+
project, it was not possible to find a
communications card connecting the
project with the required PLC.

Define a
communications
card connecting
the project with
the PLC where the
data is stored.

SVR 1040 Bad MX driver or
device (no link to
PLC found)

Bad MX driver or
device. No link was
found to the PLC.

When adding tags to an MX project, the
server has to detect which MX device
driver and channel is used to connect to
the PLC where the data is stored. It was
not possible to find a link to the
specified PLC.

Ensure that the MX
driver, device, and
channel are
configured for the
link to the PLC
containing the I/O
reference.

SVR 1041 No MX driver or
device available

There are no MX
drivers available.

There are no MX drivers for the MX
project or there are no devices
appropriate for this I/O reference.

Ensure that the
MX driver, device,
and channel are
configured for the
link to the PLC
containing the I/O
reference.

SVR 1042 Unknown project
type

A database entry
was found for an
unknown project
type.

An attempt was made to add an
MXChange tag to a project type which is
not known to the server. This can be
caused by a different version of server
and database.

Ensure that the
server and
database versions
match.

SVR 1043 Not implemented
in this version

The functionality is
not implemented in
this software
version.

An unsupported function was called.
The application uses a newer client
software version than the server.

Ensure that the
server and client
versions match.

SVR 1044 No database
records found

The search for the
specified data
returned no
information.

This is not always an error. It could
mean that a valid query was made
which returned no data.

If an operation is
persistently failing
due to this error,
contact the
application vendor.
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SVR 1045 Failed to find
database key

The field name was
not found in the
database.

An attempt was made to read or write a
miscellaneous long binary field which
could not be found.

Check whether the
database version is
valid. If the
problem persists,
contact the
application vendor.

SVR 1046 Table or field not
found in database

Failed to locate the
table or field in the
database.

An attempt was made to read or write a
miscellaneous long binary field, but the
table or the field does not exist.

Check whether the
database version is
valid. If the
problem persists,
contact the
application vendor.

SVR 1047 Node not found The requested
node was not
found in the
database.

The database might have been changed
since the node was last referenced or
this could be an internal error.

Check whether the
node still exists. Try
the operation
again.

SVR 1048 Cannot delete
module ... from
non-modular slave

The database item
cannot be deleted,
because the parent
is not a modular
slave.

A single "module" is defined for
non-modular slaves to specify the
number of inputs and outputs. It cannot
be deleted.

None

SVR 1049 Insufficient access
level to delete
nodes of class ...

You do not have
the correct access
level to delete this
node class.

The following causes are possible:
- You are not logged in.
- You have to log in at a higher access

level to delete this node class.
- It is not possible to delete this node

class.

Log in (at a higher
access level if
necessary). Try the
operation again.

SVR 1050 A node called ...
already exists

There is already a
database entry
with the same
name at the
current level.

An attempt was made to add a node
with a name already existing.

Rename the item
or delete the
existing item.

SVR 1051 Only an MX project
can modify the MX
node name ...

The MX node
name can be
modified only by
an MX project.

MX tags cannot be renamed. They must
be deleted and then added again. MX
tags are renamed only if they have been
added from elsewhere and the name
suggested collides with the name of an
existing tag. In this case, the MX
interface assigns a new name for the
MX tags automatically.

To rename the MX
tag, delete it. Then
add it again with
the new name.

SVR 1052 Some required
fields for class ...
were left blank

Some fields
required for this
database type were
left blank.

A new node was written to the
database but part of the necessary
information is missing.

Ensure that the
necessary
information was
supplied. Try the
operation again.

SVR 1053 Node ... is locked
by user ..., project
...

Another project is
currently accessing
this database item.

An attempt was made to modify or
delete a node which someone else is
currently using.

Wait until the other
user has finished.
Try the operation
again.
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SVR 1054 Cannot add node
because it is not an
MXChange tag

A routine to add an
MXChange tag to
the database was
called for
non-MXChange
tag.

This is an internal error. If the problem
persists, contact
the application
vendor.

SVR 1055 Child nodes must
be deleted before
parent node "..."

An attempt was
made to delete a
parent database
entry before
deleting the child
nodes.

Some node types cannot be deleted
until all items below them have been
deleted.

Delete the child
nodes before
deleting this parent
node.

SVR 1056 Unexpected or
unknown class ID
...

An attempt was
made to delete an
unknown
MXChange tag
type.

The application uses a newer client
software version than the server.

Ensure that the
software versions
match.

SVR 1057 Cannot find class
ID field in record
(or unexpected
format)

The class ID cannot
be found in the
database record.

When deleting an MXChange tag, an
invalid class ID was found. This is an
internal error.

If the problem
persists, contact
the application
vendor.

SVR 1058 Not allowed to
change ID, level, or
parent

Not allowed to
change ID, level, or
parent.

An attempt was made to modify the ID,
level, or parent of a node. This is not
permitted.

If any of the above
details need to be
modified, the node
must be deleted
and then added
again.

SVR 1059 Not permitted
change of
MXChange tag
address

An invalid change
has been made to
the MXChange tag
properties.

An attempt was made to change a tag's
address in a not permitted way (e.g.
changing the PLC where the I/O is
stored).

If the change is
necessary, delete
the tag and then
add it again.

SVR 1060 Missing project
specific node for
MXChange tag

Cannot find the
project specific
entry for this
MXChange tag.

It was not possible to find one of the
project specific nodes for this
MXChange tag. This can be caused by a
problem concerning the database or an
internal error.

If the problem
persists, contact
the application
vendor.

SVR 1061 MM+ range
mismatch (limit ...,
got ...)

The end address
specified in the
MM+ tag is higher
than the end
address specified in
the MXChange tag.

This can happen when the size of a
project specific tag is changed, but the
size of the MM+ tag related to it is not
changed.

Check whether the
modified tag is
compatible with
the MXChange tag.

SVR 1062 MX tag range
mismatch (limit ...,
got ...)

The end address
specified in the MX
tag is higher than
the end address
specified in the
MXChange tag.

An attempt was made to modify an MX
tag in a way incompatible with the
matching MXChange tag.

Ensure that the MX
tag remains valid
after it has been
modified. If
necessary, delete
the tag and add it
again.
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SVR 1063 MP+ tag range
mismatch (limit ...,
got ...)

The end address
specified in the
MP+ tag is higher
than the end
address specified in
the MXChange tag.

An attempt was made to modify an MP+
tag in a way incompatible with the
matching MXChange tag.

Ensure that the
MP+ tag remains
valid after it has
been modified. If
necessary, delete
the tag and add it
again.

SVR 1064 No MXChange tag
found
corresponding to
MX tag

No MXChange tag
corresponding to
an MX tag exists in
the database.

The MXChange tag has been deleted in
a way which left the MX tag "orphaned".

Delete the MX tag
and add it again.

SVR 1065 No MXChange tag
found
corresponding to
MM+ tag

No MXChange tag
corresponding to
an MM+ tag exists
in the database.

The MXChange tag has been deleted in
a way which left the MM+ tag
"orphaned".

Delete the MM+
tag and add it
again.

SVR 1066 No MXChange tag
found
corresponding to
MP+ tag

No MXChange tag
corresponding to
an MP+ tag exists
in the database.

The MXChange tag has been deleted in
a way which left the MP+ tag
"orphaned".

Delete the MP+ tag
and add it again.

SVR 1067 Cannot change
MP+ I/O card's
address if there are
I/O references

Cannot change
MP+ I/O card's PLC
address if there are
I/O references.

An attempt was made to change the
details of an MP+ I/O card, but there are
tags assigned to the card. The change
cannot be allowed, as it could invalidate
the tags.

None

SVR 1068 Invalid change to
DP slave node

DP slave node
change to device,
ID, range, or type
is invalid.

A change was made to the type, the
base PLC, the input device, or the output
device of a DP slave node. These
changes are not permitted.

None

SVR 1069 Not allowed to
change
inputs/outputs on
a DP non-modular
slave

Not allowed to
change
inputs/outputs on
a DP non-modular
slave.

A DP non-modular slave is defined with
a "module" node to define the number
of inputs and outputs. These values
cannot be changed after the slave has
been defined.

None

SVR 1070 Bad change to DP
I/O reference

Can only modify DP
input or output
references.

A DP I/O reference of an unknown type
was encountered. This can be caused by
a problem concerning the database or
an internal error.

Check the tag
details via the
Super Project
Manager.

SVR 1071 Cannot modify
module node of a
non-modular slave

An attempt was
made to modify a
module node of a
non-modular slave.

Non-modular slaves are defined with a
single "module" node to hold details of
their inputs and outputs. This node
cannot be modified.

None

SVR 1072 Unknown flag type An attempt was
made to modify a
database entry
using an unknown
flag type (i.e. not
add, modify, or
delete).

This is an internal error. If the problem
persists, contact
the application
vendor.
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SVR 1073 The child node is
not the correct
type

This type of
database entry is
incompatible with
the parent node
type.

An attempt was made to add a node
not permitted as a child node of the
specified parent node (e.g. add an MX
driver node at the top level of the
hierarchy).

None

SVR 1074 Allocate GSD class;
problem
concerning GSD
database

While preparing to
include a new GSD
slave or module, it
was not possible to
examine the GSD
database.

The following causes are possible:
- There is no GSD database node in the

database.
- The GSD database node does not

contain a valid GSD database.
- There was not enough space in the

temporary directory to extract the GSD
database.

- There is not enough free memory to
hold a copy of the GSD database.

Check whether the
GSD database
node exists. Make
sure that the GSD
database node
contains a valid
database. Ensure
that there is free
space on the drive.
Free memory to
hold a copy of the
GSD database.

SVR 1075 Allocate GSD class;
no matching slave
or module entry in
GSD database

The GSD database
does not contain a
matching entry for
the slave or module
to be allocated.

An attempt was made to add a GSD
slave or module to the system, but it
does not exist in the GSD database.

Add the slave or
module to the GSD
database. Try the
operation again.

SVR 1076 Allocate GSD class;
slave does not
support DP

The slave to be
added does not
support DP.

An attempt was made to add a GSD
slave to the system, but it does not
support the DP standard.

None

SVR 1077 Allocate GSD class;
module to allocate
has no matching
slave

There is no slave
allocated for the
module to allocate.

An attempt was made to add a GSD
module to the system, but the matching
slave has not yet been added.

Add the slave
before attempting
to add its modules.

SVR 1078 Allocate GSD class;
failed to allocate a
new class

It was not possible
to allocate a new
class for a DP slave
or module.

The maximum number of DP slaves has
been exceeded or the maximum number
of modules per DP slave has been
exceeded.

Check whether the
number of devices
assigned is below
the maximum
number. If
necessary, delete
any unused DP
devices. Try the
operation again.

SVR 1079 Allocate GSD class;
cannot free a class
in use

It was not possible
to free a DP slave
or module class,
because they are in
use.

The DP slave or module type itself is in
use or a module is in use and an
attempt was made to delete the slave.

Remove all DP
slaves and modules
of this type before
trying the
operation again.

SVR 1080 Database "..." does
not have read and
write access

It was not possible
to use the specified
database, because
it is not readable or
not writeable.

The file might be read only or it is not
accessible to the user running the server
(NT only).

Make sure that the
database file is
accessible and not
read only.
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Error Code Meaning Description Causes Actions

SVR 1081 No database to
"save as"

An attempt was
made to use "Save
as" without current
database.

No database is opened, so it cannot be
saved with a new name.

Open the database
and try the
operation again.

SVR 1082 Cannot add item to
PLC because
maximum number
of this type (...)
would be exceeded

An attempt was
made to add an
item to a PLC
which the item
does not support
or already has the
maximum number
of items of that
type.

The PLC does not support this item type
(maximum number 0), e.g. it does not
support DP cards.
The PLC already has the maximum
number of that items, e.g. it might be
limited to two Ethernet cards and unable
to support a third.

If the maxmimum
number of items of
that type has been
reached, it might
be possible to
delete one of the
existing items.

SVR 1083 Not permitted to
change PLC type

It is forbidden to
change the PLC
project type after it
has been created.

An attempt was made to change the
PLC type. This is not permitted except in
MM+.

The PLC type can
be changed only by
removing the
project and
recreating it or by
using MM+ to
change the type.

SVR 1084 Invalid PLC address An invalid PLC
address was
encountered.

An attempt was made to use an invalid
PLC address. The device type does not
exist or the specified address does not
exist for the device type.

Ensure that the
address is valid for
the PLC. Different
PLC types have
different address
ranges.

SVR 1085 Licencing limits
exceeded

An action was tried
exceeding the
limits of your
software licence.

The number of MXChange tags which
can be added has exceeded the licencing
limits.

If you need to add
more MXChange
tags than the
licence permits,
contact your
distributor.

SVR 1086 Server with
duplicate serial
number found at
address ... -
terminating!

The server is
terminating,
because another
server was found
with the same
serial number.

Each server licence allows one instance
of the server to run on a single
computer.

If you need to run
another server,
contact your
distributor.

SVR 1087 This project is
already open by
user '...'

This project has
already been
opened by another
user.

Most projects can be used by only one
person at a time. Someone else is
already using this project.

Wait until the
current user has
finished before
trying to open the
project again.
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SVR 1088 Unsupported MX
block type '...'

The requested MX
block type is not
supported by
MX32.

MX32 supports blocks with only one
base I/O address, which can have
addresses in Mitsubishi PLCs.

Use a supported
block type: AI, AO,
AR, DI, DO, DR,
AA, DA, AIL, AIM,
AIS, AOL, AOM,
AOS, DIL, DIM,
DIS, DOL, DOM,
DOS, DFL, DFM,
DFS, DXL, DXM,
DXS, TX.

SVR 1089 Not licenced to use
this version

The installed server
licence is for an
earlier version of
MXChange.

Although service releases of the same
version can be installed, running a
newer version of MXChange will require
a licence upgrade.

Contact your
distributor to
purchase an
upgrade.

SVR 1090 Current computer
is not authorised

The MXChange
server is locked to
one computer. The
current computer
has not been
authorised for
using MXChange.

After a licence has been installed (from
disk), an authorisation code must be
entered to lock the software to the
current PC.

Contact your
distributor for an
authorisation code.

SVR 1091 Trying to reuse an
MXChange tag
with different
details

An attempt was
made to reuse an
MXChange tag,
but the details did
not match.

Either the I/O device (e.g. D, M, X, Y)
or the starting I/O address was
different.

Either add the tag
with the same
details or create a
new tag.

SVR 1092 No corresponding
MXChange tag to
DP tag found

No MXChange tag
corresponding to a
ProfiMap DP tag
exists in the
database.

The MXChange tag must have been
deleted in a way which left the ProfiMap
DP tag 'orphaned'.

Delete the
ProfiMap DP tag
and add it again.

SVR 1093 An unhandled
exception occurred
during processing

An unforeseen
problem occured
while dealing with
a request.

The parameters could be incorrect. Retry the request,
making sure that
the parameters are
correct.

SVR 1094 User not found The user name is
not known.

The user name was typed incorrectly or
there is no such user name for this
database.

Ensure that the
name was typed
correctly. If it was,
the user name is
not valid for this
database.

SVR 1095 Cannot add I/O
references with this
API call

It is not possible to
add I/O references
with certain API
calls.

This would normally occur if an
application tried to use AddNodes() to
add I/O references.

Contact the
application vendor
if the problem
persists.
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SVR 1096 Cannot perform file
operation because
other users are
connected

An attempt was
made to change
the database
(open/close/new)
while other users
were still
connected to it.

It is not possible to select another
database unless you are the only user
connected.

Make sure that all
other users have
disconnected from
the database and
then try again.

SVR 1097 The database
specified is already
connected to
another server

An attempt was
made to connect
the server to a
database that is
already connected
to another server
instance.

It is not possible for more than one
server instance to be connected to the
same database.

Access the server
instance that is
already connected
to the database
required.

SVR 1098 Failed to parse
import file at line
...

An incorrect layout
was encountered
while parsing an
import file. The
error occurred at
the line shown (the
first line is
numbered as one).

The export file version might not be
supported (if the error occurs on the
header line).

Only use export
files suitable for
the current version.
If you have
generated the file
yourself, copy the
header from an
automatically
produced export
file.

The file layout could be incorrect. Examine the file to
check the layout. If
you have edited
the file yourself,
check that it
matches the layout
of an automatically
produced export
file, including the
header.

A tag could have an invalid address. Make sure that the
address of the tag
on the offending
line is valid by
entering it directly
in Super project
manager.

There might not be enough fields on the
line.

Make sure that the
line has enough
fields - the first
three fields must
always be provided
for a tag, although
other fields can be
left as default
values.
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SVR 1099 No tags found in
import file

An attempt was
made to import a
file which
contained no tags.

The file did not contain any tags. Examine the file
with notepad to
confirm that the
contents are
correct.

SVR 1100 Element size of
type '...' should be
...

An attempt was
made to set the
size of a data type
to an incorrect
value.

The size does not match the normal size
of the type, e.g. an integer is two bytes.

Change the size to
match - the
expected size is
shown in the error
message.

The size of a STRING was set to 0. Change the size of
the STRING to 1 or
more.

SVR 1101 Tag has unknown
data type

An attempt was
made to set or
change the data
type of a tag to an
unknown value.

The type of a tag was changed to one
which is not known to MXChange.

Use of of the data
types available in
Super project
manager.
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